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1 PCR AMPLIFICATION USING THE AMPFℓSTR® YFILER™ PCR AMPLIFICATION KIT

A dedicated area, such as a biological hood or a separate room, should be used for preparing PCR amplification
reactions. All equipment and supplies used to prepare amplification reactions should be kept in this dedicated "clean"
area at all times. These items will not be used to handle amplified DNA or other potential sources of contaminating
DNA. Trace amounts of amplified DNA, if carried over into other samples before amplification, can lead to results that
can be misinterpreted. Amplified DNA or equipment and supplies used to handle amplified DNA will NOT be brought
into the designated "clean" area. Clean disposable laboratory gloves will be worn while preparing samples for PCR
amplification and will be changed frequently or whenever there is a chance they have been contaminated with DNA.

DNA samples will be added to the amplification plate AFTER the AmpFℓSTR® YfilerTM master mix has been added to 
all wells used in the plate.

1.1 Equipment

 9700 Thermal Cycler
 Pipettes - 2 µL, 10 µL, 20 µL, 100 µL, 200 µL, and/or 1000 µL
 8- Channel Pipette – Range 0.5 µL to 10 µL
 Repeater pipette
 Biological Safety Hood
 Microcentrifuge tube racks

1.2 Materials

 Sterile ART pipette tips - 10 µL, 20 µL, 100 µL, 200 µL, and/or 1000 µL
 Repeater pipette tips – 1250 µL
 Microcentrifuge tubes
 Kim-wipes
 Gloves
 96-well amplification plates and strip caps

1.3 Reagents

 AmpFℓSTR® YfilerTM Amplification Kit (Applied Biosystems, Inc. P/N 4359513) 
 Sterile Type I Water

NOTE: The AmpFℓSTR® YfilerTM Allelic Ladder supplied in the AmpFℓSTR® YfilerTM System kit does not 
require amplification and should not be stored in the sample preparation area.

1.4 AMPFℓSTR® YFILERTM System Amplification Procedure for the 9700 Thermal Cycler

1.4.1 Amplification Parameters for the 9700 Thermal Cyclers:

If the thermal cycler has not already been programmed, program as follows: 

Initial incubation for 11 minutes at 95oC.

Denature at 94C for 60 seconds
Anneal at 61C for 60 seconds 
Extend at 72C for 60 seconds

Program for 29 cycles

Final extension at 60C for 80 minutes
Final hold at 4oC. 
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NOTE:  Use the program time 99:59 minutes (infinity) for the final hold cycle 

1.4.2 Transfer the AmpFℓSTR® YfilerTM amplification reagents to the designated "clean" area.

1.4.3 Calculate the required volume of each PCR amplification component to prepare a Master Mix by 
multiplying the volume by the number of samples. This should include a reagent blank, positive and 
negative amplification controls, and two to three additional reaction volumes (depending on the number 
of samples being amplified) to compensate for any pipetting variation. The PCR Master Mix should be 
prepared in a clean 1.5 mL microcentrifuge tube. Briefly vortex the tubes containing the YfilerTM PCR 
Reaction Mix and YfilerTM Primer Set. The PCR Reaction mix may be pulse spun in a microcentrifuge to 
remove any liquid from the caps. Do not spin the primer set.

PCR Master Mix per sample for half-reaction volume:

4.6 µL YfilerTM PCR Reaction Mix
2.5 µL YfilerTM Primer Set 
0.4 µL AmpliTaqTM Gold Enzyme (4 Units)

1.4.4 Add 7.5 µL of PCR Master Mix to each well of the labeled 96-well plate. Cap each column of the plate 
and ensure that the solution is at the bottom of the well, gently tapping the plate on the counter top, if 
necessary.

NOTE: Each YfilerTM amplification is performed in a final volume of 12.5 μL. Exactly 5 μL has been 
allocated for sample DNA and/or water. 

1.4.5 Prepare the sample DNA and controls as follows:

NOTE: A witness must be used when transferring extract from the 1.5mL microcentrifuge tube into 
the corresponding well of the 96 well amplification plate.

1.4.5.1 Dried blood stains: Carefully add 3.0 μL or what has been determined to be the optimal 
volume of extracted DNA to the appropriate labeled sample well. Bring the total volume up to 
5 μL by adding sterile Type 1 Water to the well.

1.4.5.2 Dried buccal cells: Carefully add 2.0 μL or what has been determined to be the optimal 
volume of extracted DNA to the appropriate labeled sample well. Bring the total volume up to 
5 μL by adding sterile Type 1 Water to the well.

1.4.5.3 Positive Amplification Control: Gently mix by hand the 007 Control DNA (stock 
concentration is 0.1 ng/ μL in 0.05% sodium azide buffer) followed by a light tapping of the 
tube on the counter top to remove any liquid from the cap. Carefully add 5 μL (0.5 ng total) of 
DNA of the Control DNA to the appropriate well.

1.4.5.4 Negative Amplification Control: Carefully add 5 μL of sterile Type I water to the appropriate 
sample well. 

1.4.5.5 Reagent Blank: Carefully add 5 μL of the reagent blank to the appropriate sample well. 

1.4.6 Place the plate into the thermal cycler and tighten the lid.

1.4.7 When the thermal cycler prompts the user for the sample volume, choose 13 µL.

1.4.8 Start the amplification file.

NOTE:  The PCR amplification program will run for approximately 4 hours. 
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1.4.9 If the samples will not be loaded into the CE within a working day, the samples should be stored only in 
the post-amplification area of the laboratory and in the dark at 2 C to 8 C for a few days or at -20 C for 
extended periods. 

NOTE: Store amplified DNA samples separately from PCR pre-amplification reagents and extracted 
DNA samples.
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2 CAPILLARY ELECTROPHORESIS

For the purpose of this manual, the following definitions apply:

Injection - all samples that were separated via CE at a single time. Thus, for one injection on the 3500xL, up to 
24 samples can be separated at a single time.

Run - all samples that were defined on a single plate and loaded onto the instrument at a single time for 
separation, regardless of the number of injections utilized to separate each sample contained on the plate. Thus, 
a run could contain up to 96 samples for separation on a single plate.

 
2.1 Equipment

 Applied Biosystems 3500xL Genetic Analyzer
 96-well centrifuge
 Heat block, capable of 95oC
 Pipettes - 10 µL, 20 µL, 100 µL, 200 µL and/or 1000 µL
 8-Channel Pipette - Range 0.5 µL to 10 µL
 Repeater Pipette

2.2 Materials

 36-cm capillary array (Applied Biosystems, Inc. P/N 4404687 (24-capillary))
 Optical 96-Well Reaction Plate (Applied Biosystems, Inc. P/N N8010560) 
 96-well plate septum (Applied Biosystems, Inc. P/N 4315933)
 96-well plate retainer and base (Applied Biosystems, Inc. P/N 4409530)
 Freezer block
 Aerosol-resistant tips for pipettes – 10 µL, 20 µL, 100 µL, 200 µL, and 1000 µL 

2.3 Reagents

 Hi-Di Formamide (Applied Biosystems, Inc. P/N 4311320)
 Yfiler™ Allelic Ladder (Appied Biosystems, Inc, P/N 4373675)
 GeneScan™ 600 LIZ® Size Standard v2.0 (Applied Biosystems, Inc. P/N 4408399)
 POP-4 Polymer (Applied Biosystems, Inc. P/N 4393715 (384 samples) or P/N 4393710 (960 samples))
 Anode buffer container (Applied Biosystems, Inc. P/N 4393925)
 Cathode buffer container (Applied Biosystems, Inc. P/N 4408256)
 Cathode buffer septa (Applied Biosystems, Inc. P/N 4410715)

2.4 Safety Considerations

The Applied Biosystems 3500xL Genetic Analyzer uses single-line 505nm, solid-state laser. All instrument 
panels must be in place on the instrument while the instrument is operating. When all panels are installed, 
there is no detectable radiation present. If any panel is removed when the laser is operating, (e.g., during 
service with safety interlocks disabled) you may be exposed to laser emissions in excess of the Class 3B 
rating. Do not remove safety labels or disable safety interlocks.

Performance Optimized Polymer (POP) is an irritant, always wear gloves when handling or cleaning liquid or 
dried polymer. It may cause skin, eye, and respiratory tract irritation.

Exposure to Hi-Di Formamide causes eye, skin, and respiratory tract irritation. It is a possible developmental 
and birth defect hazard. Read the MSDS, and follow the handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves.
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2.5 References

 Applied Biosystems. AmpFℓSTR® Yfiler™ User’s Guide, rev J (4/2014).
 Applied Biosystems 3500/3500xL Genetic Analyzer User guide (2010).

2.6 Instrument Preparation

2.6.1 With the 3500xL turned off, turn on the computer, but do NOT log on.

2.6.2 Power on the 3500xL instrument. Wait for the solid green light indicating the initialization process is 
complete.

2.6.3 Log onto the computer and the Server Monitor/Daemon will launch automatically. The Server 
Monitor is completely loaded when the green check mark appears in the lower right corner of the 
screen.

2.6.4 After the Server Monitor/Daemon is fully loaded and there is a green light on the front of the 
3500xL instrument, the 3500 Series Data Collection Software may be opened.

2.6.5 On the Dashboard screen, ensure the oven temperature is set to 60°C, and then select “Start Pre-
Heat” at least 30 minutes prior to the first injection to preheat the oven.

2.6.6 Click “Refresh” in the “Consumables Information” window. The readings/gauges will be updated 
once the RFID tags are read. 

2.6.6.1 Anode and cathode buffer containers will need to be changed if they have been on the 
instrument longer than fourteen days or they have expired. See Appendix C of the DB 
Fusion Procedures Manual for additional information regarding changing either buffer.

2.6.6.2 Verify that enough polymer remains in the pouch (# of samples remaining / # injections 
remaining). Also verify that the polymer has not been on the instrument longer than 14 
days and that it has not expired. If the polymer is old, expired or an insufficient number 
remains, the polymer pouch will need to be changed prior to starting the run. See 
“Replenish Polymer” in Appendix C of the DB Fusion Procedures Manual for additional 
information.

2.6.7 Check the 3500xL instrument and perform the pre-run tasks below.

TASK FREQUENCY FOR MORE 
INFORMATION

Visually inspect the level of fluid inside the ABC 
and the CBC. The fluid must line up with the fill 
line.

Before each run Appendix C of the DB Fusion 
Procedures Manual – 
Changing the ABC or CBC

Ensure that the plate assemblies are properly 
assembled.

IMPORTANT! Align the holes in the plate retainer 
with the holes in the septa to avoid damaging 
capillary tips.

Before each run

Ensure that the plate assemblies and the CBC and 
septa are sitting securely on the deck.

Before each run

Check for bubbles in the pump block and channels.

Note: Use the “Remove Bubbles” wizard to remove 
bubbles. 

Before each run Appendix C of the DB Fusion 
Procedures Manual – Remove 
Bubbles wizard
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Check the loading-end header to ensure that the 
capillary tips are not crushed or damaged. If crushed 
or damaged, the capillary array will need to be 
changed.

Before each run Appendix C of the DB Fusion 
Procedures Manual – Install 
the Capillary Array

Clean the instrument surfaces of dried residue, 
spilled buffer, or dirt.

Before each run

Check for leaks and dried residue around the Buffer-
Pin Valve, Check Valve Fitting, and Array-Head 
Locking Mechanism. If leaks persist, contact AB.

Before each run

2.7 Sample Preparation

2.7.1 To prepare a convicted offender/arrestee sample plate, vortex LIZ ILS 600 to mix. Thaw the Hi-Di 
formamide and vortex to mix.

2.7.2 Prepare a Master Mix of formamide and size standard by combining reagents as follows:

[(0.5ul LIZ ILS 600 v2.0) X (# samples)] + [(8.5ul Hi-Di formamide) X (# samples)]

NOTE: When calculating, include an extra number of samples to account for pipetting variation. 
The number of extra samples needed will be dependent upon the total number of actual 
samples being loaded.

2.7.3 Vortex the Master Mix to ensure the contents are thoroughly mixed.

2.7.4 Pipet 9.0 µL of the Master Mix into each used well of the 96-well plate. 

2.7.5 Pipet 9.0 µL of extra Master Mix or Hi-Di formamide into any unused wells of the plate that are in a 
set of three columns in which samples/ladder will be injected to prevent the injection of air by the 
instrument.

2.7.6 Place the plate septum on top of the sample wells and use a scalpel to cut the septum into single 
column strips. During the amplified DNA transfer, only one column of both the CE plate as well as 
the amplification plate should be open at a time. Pipet PCR product (samples, positive controls, and 
negative controls) into the corresponding well of the 96-well plate. Typically, 1 µL of PCR product 
will be added. However, 0.5 µL or 2 µL of the PCR product may be used at the analyst’s discretion 
and will be noted on the technical documentation.

NOTE: The greatest volume of PCR product used for the samples must also be used for the 
negative control(s) and reagent blank(s). 

2.7.7 Pipet 1 uL of allelic ladder into at least two wells per plate.

2.7.8 Cover the wells with appropriate septa and centrifuge the plate briefly to remove air bubbles from all 
wells.

2.7.9 Just prior to loading the instrument, denature samples at 95oC for 2 minutes, then immediately chill 
in a freezer block for 2 minutes.

2.7.10 Place the denatured and chilled plate into a blue plate base and snap the white plate retainer over the 
top, taking care to align the tabs on both ends. 

2.7.11 Press the tray button on the 3500xL to bring the autosampler tray forward. Open the instrument door 
and place the plate assembly into an open position (A or B) with the labeled end of the white plate 
retainer facing you.



2 Capillary Electrophoresis 

211-D601 DNA Data Bank Procedures Manual, Y Filer Qualtrax ID: 18398
Issued by Biology Program Manager Uncontrolled When Printed Qualtrax Revision 4
Issue Date: 09-October-2023 Page 9 of 23

2.7.12 Close the instrument door. 

2.8 Instrument Operation

2.8.1 Importing a plate file

2.8.1.1 To import a plate file, click on “Library>Plates” in the navigation pane.

2.8.1.2 Click “Import”. Use the drop down menu to select “*.xls”. Browse to find the selected 
run file. Double click to import the correct file. Click “OK” after verifying the correct file 
was imported.

2.8.1.3 Open the imported file. Verify the information is correct and proceed to 2.8.3, “Linking 
plate for run”.

2.8.2 Manually entering a plate file

2.8.2.1 Sample information may also be entered manually. In the Dashboard, click “Create New 
Plate” and enter the plate details.

2.8.4.2.1Enter the plate name
2.8.4.2.1Number of wells: 96
2.8.4.2.1Plate Type: HID
2.8.4.2.1Capillary Length: 36cm
2.8.4.2.1Polymer: POP-4
2.8.4.2.1Owner initials

2.8.2.2 Click on “Assign Plate Contents”

2.8.2.3 Using either the “Plate View” or “Table View”, enter the sample names in the 
appropriate well.

2.8.2.4 Under “Assays” click “Add from Library”. Select the appropriate file from the list and 
close the window. Data bank samples will be run with “Yfiler 24sec” and/or “Yfiler 
12sec” or “Yfiler 12 and 24sec”.

2.8.2.5 Under “File Name Conventions” click “Add from Library”. Select “Databank” from the 
list and close the window.

2.8.2.6 Under “Results Groups” click “Add from Library”. Select “Databank” from the list and 
close the window.

2.8.2.7 Highlight all samples to be run and click the check box in “Assays”, “File Name 
Conventions” and “Results Groups”.

2.8.2.8 In “Table View”, use the drop down under “Sample Type” to designate the Negative 
Control, Positive Control and Allelic Ladders. All other samples should remain 
“Sample”.

2.8.2.9 In the “UD2” (user defined comment) field, add the appropriate letters to indicate the 
specimen category.

2.8.2.10 Save the plate file.

2.8.3 Linking plate for run

2.8.3.1 Click “Load Plates for Run” in the navigation pane.
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2.8.3.2 Plates must be loaded onto the autosampler tray before it may be linked for a run. Click 
“Link Plate” in the appropriate position (A or B). Browse in the pop-up window to find 
the appropriate plate file. Double click on plate name to select, and then close the 
window.

2.8.3.3 Click “Start Run”. The instrument will notify you at this time if there is any instrument or 
reagent issue with the requested run. If an issue is detected, the run will not begin until 
the issue is resolved.

2.8.3.4 Alternatively, you may click “Create injection list”. Preview the injection list and move 
selected injections up or down to change the injection order. Once the order is 
determined, click “Start Run”. The injection order may also be changed once the run has 
begun with the exception of the first injection, which is running.

2.8.3.5 Once “Start Run” has been clicked, the instrument will notify the user if there are any 
instrument or reagent issues with the run. If an issue is detected, the run will not begin 
until the issue is resolved. Expired reagents may not be used for Data Bank samples. 
However, a capillary array may be used past the manufacturer’s recommended use as 
long as the quality of the data obtained does not decline. If this is the reason for the 
notification, click on “Use” to continue.

2.8.4 Re-injections

2.8.4.1 Re-injections may be designated in two ways and are outlined below.

NOTE: The same injection time or longer than that used for the samples must be used 
for the negative controls and reagent blanks.

2.8.4.2 Re-injections may be designated on a plate while the plate is running on the instrument. 
After the run has started, in the “Monitor Run” screen, highlight the desired wells or 
select the desired injection to designate for re-injection. 

2.8.4.2.1 To collect data for all wells in an injection, select the injection in the 
injection list. Click the “Re-Inject” button.

2.8.4.2.2 To collect data for only specific wells, select the injection. Then select in 
the array view the capillary that corresponds to the well or sample of 
interest. Click the “Re-Inject” button.

2.8.4.2.3 In the re-injection dialog box, select options, then click OK.

 The protocol to use for the re-injection: original, modified, new, or one 
from the library.

 When to make the injection.

2.8.4.2.4 If you select to re-inject a sample that includes an allelic ladder in its results 
group, but the allelic ladder is not part of the injection, the software prompts 
you to select one or more allelic ladder samples to re-inject.

2.8.4.2.5 In the “Add Allelic Ladder to Re-Injection” screen, select one or more 
allelic ladder samples and then select whether to collect data for the 
remaining samples in the allelic ladder re-injection.

2.8.4.2.6 Then select whether to apply a modified instrument protocol to the allelic 
ladder re-injections, or whether to use the original instrument protocol for 
the allelic ladder re-injection(s). You will select the modified protocol in the 
next screen.
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2.8.4.2.7 The injections will be designated on each well of the plate. Review for 
accuracy and change if necessary.

2.8.4.3 Alternatively, the plate file may be re-created using a different name. Typically re-
injection files are named by appending “R” to the end of the plate file name. Select the 
“Assay” that designates the desired injection time. 

2.8.4.3.1 If this option is chosen, the plate will need to be linked and run after the 
original plate run is completed.

2.8.4.4 To pause a run, click “Pause Run” and the run will pause after the current injection 
completes.

2.8.4.4.1 “Resume Run” will resume the run.

2.8.4.5 To abort a run, click “Abort Injection” and the current injection immediately aborts and 
pauses the instrument run. You can resume the run or terminate the injection list. Do not 
click “Delete” to stop an injection.

2.8.4.6 To terminate an injection list, click “Terminate Injection List” and the instrument run will 
stop. Terminate is only active after you click “Pause Run” or “Abort Injection”.
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3 ANALYSIS AND INTERPRETATION OF CAPILLARY ELECTROPHORETIC DATA

GeneMapper® ID-X (GMIDx) is an automated genotyping software program for forensic data analysis that supports 
analysis of electropherogram data obtained from the 3500xL Genetic Analyzer.

Refer to the GMIDx Software Document Set (Applied Biosystems™) for the initial set up of the GMIDx software 
specific to each kit chemistry that will be analyzed.

3.1 Project Window

3.1.1 Open the GMIDx software. Select the appropriate user name and enter password.

3.1.2 To begin the data analysis, samples must be added to the project to be analyzed. 

NOTE:  All samples to be analyzed from a single run should be added at once. If not done in this manner, 
the software may not associate the correct allelic ladders with the given samples. 

3.1.3 Choose “Edit” and “Add Samples to Project”.

3.1.4 Browse to the data files to analyze. You may select the entire folder or pick the files within the folder to 
analyze.

3.1.5 Click “Add to List” (bottom left of screen) then “Add” (bottom right of screen).

3.1.6 Name the project when prompted.

3.1.7 Upon addition of the samples to the project, the “Samples” tab will become populated. Double-check to 
ensure that the correct panel, sample types, and analysis method are selected. If changes need to be made 
to this information, select the necessary cells and choose the appropriate settings from the drop-down 
menus. Verify that the information is correct before proceeding.

 Analysis Method = “Yfiler_DB”
 Panel = “Yfiler_v1.3x”
 Size Standard = “GS600_LIZ_DB”

3.1.8 Analyze the samples by clicking the green arrow:          (Analyze).

3.2 Examining the Internal Lane Standard Results

3.2.1 Check the size standard results by examining the flags in the SQ (sizing quality) column. A green square 
indicates that a sample has passed the sizing criteria. If the sizing quality column indicates failure (a red 
octagon), the sample will not be genotyped by the software until the size standard has been adjusted or, if 
necessary, the sample is re-injected. For samples that do not pass the sizing criteria, indicated by a yellow 
triangle or red octagon, assess the size standard by highlighting the sample(s) and click on the         icon 
or select Tools>Size Match Editor. 

3.2.2 Upon entering the Size Match Editor window, the recognizable pattern of the size standard peaks should 
appear; the peaks below 80 and above 420 may be left undefined.
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Figure 1. GeneScanTM 600 LIZ® Size standard v2.0. The peaks are labeled with their base pair size. 

3.2.3 If the sizing standard is observed for the sample, check to see that all peaks are detected and the peaks are 
labeled correctly. The peaks should follow the pattern shown in Figure 1.

3.2.3.1 If a required size standard peak is not shown or the size standard peaks are mis-labeled, the 
following may need to be adjusted (see 3.2.4): Analysis Start and/or Stop point(s) in the 
associated Analysis Method, or the LOD value for the associated dye color. Alternatively, the 
size standard peaks may be manually defined if they appear to be mis-labeled (see 3.2.5).

3.2.4 To adjust the Analysis Start and/or Stop point(s) or the LOD value for the size standard dye in the 
associated Analysis Method, exit the Size Match Editor window. Be sure that any one sample in the 
project is highlighted and click on the icon or select Tools>Analysis Method Editor.

3.2.4.1 All of the settings should remain the same with the exception of the Start and/or Stop points 
or the size standard LOD.

3.2.4.2 Click on the “Peak Detector” tab, if necessary

3.2.4.3 The Analysis range Start and/or Stop points may be redefined to increase/decrease the 
window of raw data analyzed such that all required size standard peaks are included while 
avoiding, if possible, the inclusion of the initial primer peaks and/or excess noise. If 
necessary, the size standard LOD may be redefined to allow for all required peaks to be 
detected.

3.2.4.3.1 The raw data for the sample files in the project may be viewed to assist in 
choosing an appropriate Analysis Start and/or Stop point, if desired.

3.2.4.3.2 To view raw data for a sample file, exit the Analysis Method Editor. Select 
View>Raw Data. The cursor can be used to hover over the area just after the 
primer peaks are observed and just before the first required size standard 
peak is observed to assist in selecting an appropriate Analysis Start Point. 
Likewise, the cursor can be used to hover over the area just after the last 
required size standard peak is observed to assist in selecting an appropriate 
Analysis Stop Point. 

3.2.5 To manually define the size standard peaks for a sample, highlight the sample of interest and click on the       
     icon or select Tools>Size Match Editor.
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3.2.5.1 Right click on the peak to be added/deleted/changed and select the appropriate action. If 
applicable, double-click on the correct base pair size for this size standard peak in the drop 
down menu that appears. Continue to do this for each size standard peak until the peaks are 
labeled correctly. Click ‘Apply’ and then ‘OK’.

3.2.6 Re-analyze the entire project by clicking the arrow icon (        ) or selecting Analysis>Analyze All. 
Alternatively, only the affected samples may be highlighted together and the user may select 
Analysis>Analyze Selected Samples.

3.3 Examining Allelic Ladder Results

3.3.1 In the “Samples” tab, select each allelic ladder. Display the plots by clicking the sample plots 
icon:          .

3.3.2 Verify that the allelic ladder is called correctly for each locus. Figure 2 represents an example of an 
AmpfℓSTR® Yfiler™ allelic ladder.

Figure 2. AmpfℓSTR® Yfiler™ Allelic Ladder

3.4 Examining the Reagent Blank

3.4.1 The reagent blank should be checked to ensure that no amplification product (labeled peaks) was 
observed. A labeled peak fits the criteria to be designated an allele or OL (off ladder) and is above the 
allele-calling threshold designated in the software.

3.4.1.1 If a single peak is detected in the reagent blank at a single locus, the test results associated 
with the reagent blank will be evaluated against the samples around it to determine whether 
the result can be used. 
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3.4.1.1.1 If the reagent blank will be used as-is, the Forensic Biology Program Manager 
or designee must grant approval. Documentation of this approval will be stored 
in the file. 

3.4.1.2 Alternatively, if the reagent blank is re-injected or re-prepared and the result does not 
reproduce the peak, this reagent blank result can be used without subsequent approval. The 
original sample injections can then be analyzed.

3.4.1.2.1 If neither option above is utilized, then the reagent blank and all associated 
samples must be re-extracted and/or re-amplified.

3.4.2 If a peak is detected in the reagent blank at multiple loci, the test results for all loci will be considered 
inconclusive and all samples will be re-extracted and/or re-amplified.

3.4.3 For a typing result to be reported, the reagent blank must have been treated appropriately (i.e., same or 
longer injection times and same or larger volumes loaded into the injection cocktail).

3.5 Examining the Negative Amplification Control

3.5.1 The negative amplification control should be checked to ensure that no amplification product (labeled 
peaks) was observed. A labeled peak fits the criteria to be designated an allele or OL (off ladder), and is 
above the allele-calling threshold designated in the software.

3.5.1.1 If a peak is detected in the negative amplification control at a single locus, the test results 
associated with the negative amplification control will be evaluated against the samples 
around it to determine whether the result can be used. 

3.5.1.1.1 If the negative amplification control will be used as-is, the Forensic Biology 
Program Manager or designee must grant approval. Documentation of this 
approval will be stored in the file. 

3.5.1.1.2 Alternatively, if the negative amplification control is re-injected or re-prepared 
and the result does not reproduce the peak, the negative amplification control 
result can be used without subsequent approval. The original sample injections 
can then be analyzed.

3.5.1.1.3 If neither option above is utilized, then the negative and all associated samples 
must be re-amplified.

3.5.1.2 If a peak is detected in the negative amplification control at multiple loci, the test results for 
all loci will be considered inconclusive and all samples will be re-amplified.

3.5.2 For a typing result to be reported, the negative control must have been treated appropriately (i.e., same or 
longer injection times and same or larger volumes loaded into the injection cocktail).

3.6 Examining the Positive Amplification Control

3.6.1 The positive amplification control DNA supplied with the AmpFℓSTR® Yfiler™ kit is 007. The correct 
type is as follows:

Locus Haplotype 007
DYS456 15
DYS389I 13
DYS390 24

DYS389II 29
DYS458 17
DYS19 15
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DYS385a/b 11,14
DYS393 13
DYS391 11
DYS439 12
DYS635 24
DYS392 13

Y GATA H4 13
DYS437 15
DYS438 12
DYS448 19

3.6.2 If the positive control has injected poorly, it can be re-injected, or if necessary, re-prepared and injected. 
The original sample injections can be analyzed if the correct types for the positive control are 
documented upon the re-injection or re-run. 

3.7 Examining Data Bank Samples

3.7.1 Each electropherogram will include the peaks from each locus labeled with the designated allelic 
number, base pair size and the height of the peak (in rfu).

3.7.2 Since convicted offender and arrestee samples are not quantified prior to amplification, the over-
amplification of some samples will occur which may result in artifacts. Most of these artifacts will be 
below the 20% global filter cut-off applied by the sizing software. Application of the global filter causes 
all peaks below 20% of the highest peak within each marker not to be labeled.

3.7.2.1 If an analyst believes that a peak is real and the software does not label the peak due to the 
applied filter, the analyst may remove the filter and reanalyze the sample to better evaluate the 
peak in question.

3.7.3 If it is determined that a sample contains stutter peaks at a majority of the loci, and other artifactual peaks 
are visible throughout the electropherogram due to injecting too much and/or amplifying too much 
sample DNA, the sample may be re-injected using a reduced injection time and/or using less amplified 
DNA in the injection cocktail. Samples may also be re-amplified with less template DNA and then re-
typed. If, however, the accurate profile can be determined from the original sample profile by both the 
analyst and the independent technical reviewer, then the data may be used.

3.7.4 For analysis of sample data, all electropherograms must be visually evaluated by the analyst to ensure 
that artifacts are not mislabeled. If a peak is mislabeled (e.g., stutter, spike, pull-up, etc.), the allele call 
can be electronically edited by the analyst.

3.7.4.1 To edit the allele call, select the peak of interest and click delete.

3.7.4.2 The user will be prompted to add a comment which will be maintained in the audit trail for 
the sample in GMIDx. For Data Bank convicted offender and arrestee samples, all deleted 
peaks will be considered to be “ART” and the display of the allele edit comment in the plot 
setting is not necessary.

3.7.5 All sample data must be reviewed carefully, with special attention paid to samples that display a yellow 
triangle or red octagon, indicating low quality analysis data.

3.7.5.1 A green square indicates that the data passed the initial (automated) analysis by the software 
in the respective category (such as sizing quality, off-scale data, etc.).

3.7.5.2 If a flag is yellow or red, it may be helpful to look at the raw data to determine the problem. 
To look at the raw data from the samples tab, highlight the sample and select View>Raw 
Data.
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3.7.5.3 If it is determined that the sample should not be considered for interpretation due to 
problems within the raw data, the sample may be re-injected or run again using a different 
amplification reaction, more PCR product, less PCR product, or other necessary procedures.

3.7.5.4 If the sizing quality for a given sample is low, the sample will not be typed by the software.

3.7.6 Convicted offender and arrestee samples are expected to exhibit single source profiles. If more than one 
DNA profile is seen in a single sample, the sample will be re-extracted and/or re-amplified.

3.7.7 An independent electronic review must be performed for each sample and will be conducted by the 
technical reviewer using the GMIDx software.

3.8 Identifying Amplification Artifacts

Each sample must be reviewed carefully and any artifacts, (e.g., pull-up, stutter/elevated stutter, spikes, etc.) 
identified and labeled appropriately.

3.8.1 Incomplete +A nucleotide addition is indicated by a peak or apparent shoulder one base pair shorter than 
the true peak. The PCR process using AmpliTaq Gold® is optimized such that an additional adenosine 
nucleotide is added onto the extended fragment. Excessive input DNA makes the adenosine addition less 
efficient and thus PCR fragments are shorter by one nucleotide than the true amplicon size (-A).

3.8.2 Pull-up refers to peaks that are not true alleles but result from poor color separation of the raw data or 
off-scale data in one or more channels. Repeated excessive pull-up may indicate the need to perform a 
spectral calibration on the instrument.

3.8.3 Fluorescence intensity that exceeds the linear dynamic range for detection by the instrument is labeled 
"off-scale" data. Quantitation (peak height and area) for off-scale peaks is not accurate. An allele peak 
that is off-scale can cause the corresponding stutter peak to appear higher in relative intensity, thus 
increasing the calculated percent stutter.

3.8.4 Stutter peaks are most commonly 2, 4 and 8 nucleotides smaller or larger than the amplicon size (true 
peak). Stutter is typically more pronounced when excessive quantities of DNA are placed into the 
amplification cocktail. Not all of the loci contained within the AmpFℓSTR® Yfiler™ System kit consist 
of four nucleotide repeats: the DYS392 locus consists of a three nucleotide repeat, the DYS438 locus 
consists of a five nucleotide repeat and the DYS448 locus consists of a six nucleotide repeat. Thus, 
stutter peaks are typically multiples of the locus repeat lengths: DYS392 will display stutter that is three 
nucleotides, DYS438, five nucleotides and DYS448, six nucleotides different in size.

3.8.4.1 The GMIDx software applies a stutter filter to detect stutter peaks that are less than 20% of 
the parent peak.

3.8.4.2 If the ratio of the peak height for the smaller peak to the larger parent peak is less 20%, the 
allele will be considered stutter by GMIDx and no allele will be designated, even if it is 
suspected that the peak is a true allele.

3.8.4.3 If the ratio of the peak height for the smaller peak to the larger parent peak is above 20% (this 
event is generally observed in samples containing a high concentration of DNA, or DNA that 
is partially degraded), the allele may still be called stutter once all loci have been taken into 
account and both the analyst and the independent technical reviewer are in agreement (based 
upon knowledge of the system and experience) that the smaller peak is stutter.

3.8.5 Spikes are CE-related artifacts in which minor voltage changes or urea crystals passing by the laser can 
cause “spikes” or unexpected peaks. Spikes sometimes appear only in one channel but often are easily 
identified by their presence in more than one channel at the same location. Spikes can frequently 
resemble peaks, but are characterized by their very narrow width. GMIDx has an algorithm that 
discriminates between true peaks and spikes, although, occasionally, the analyst may encounter a spike 
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called as an allele. While the signal spike does not result from an actual DNA fragment, the software 
cannot always make this distinction and therefore calculates a size in base pairs for the spike.

3.9 Microvariant / Off-Ladder Variant Interpretation and Nomenclature

3.9.1 If an allele is labeled as “off ladder” (OL), careful review of the data should be conducted to 
determine if the allele is truly a microvariant/off-ladder allele or if the allele is an artifact.

3.9.1.1 If multiple OL calls are made within one electropherogram, the allelic ladders and size 
standard for that sample should be reviewed for accurate calling.

3.9.1.2 If any allele designation is changed from OL to a custom designation, then “FROM OL” 
must be entered into the Allele edit comment.

3.9.2 If a true microvariant or other off-ladder allele is observed (and, if necessary on a sample-by-sample 
basis, confirmed by re-injection and/or re-amplification of the sample), the nomenclature described 
below will be used.

3.9.3 If the allele is not labeled by the GMIDx software because it does not fall into a marker range, then 
the marker range may be changed so that the allele can be labeled. Approval for this change must be 
obtained from the Forensic Biology Program Manager or designee and documentation will be 
maintained in the technical documentation. Caution must be taken to ensure the marker range setting 
is restored to its original setting after the peak is labeled.

3.9.4 If a peak is visually between two allelic ladder peaks of the same locus (a MV), assign an allele 
designation of the lower repeat value followed by the number of bases in the incomplete repeat.

EXAMPLE: An allele that migrates one base pair below the DYS456 14 allele will be designated as a 
DYS456 13.3. The “off ladder” value on the electropherogram will be manually changed 
to reflect the allele designation.

3.9.4.1 To call the MV allele accurately, the sample electropherogram and ladder electropherogram 
will be highlighted together and the plots displayed. Deselect all color channels except the one 
in which the locus in question exists and show two panes. Magnify the locus in question. The 
bins should be shown to better demonstrate where the MV falls.

3.9.5 If the peak is seen to the right of the largest ladder peak of the largest MW locus, assign the allele to the 
largest MW locus and assign an allele designation of >X, where X is the largest ladder peak in the largest 
MW locus.

3.9.6 If the peak is seen to the left of the smallest ladder peak of the smallest MW locus, assign the allele to the 
smallest MW locus and assign an allele designation of X, where X is the smallest ladder peak in the 
assigned locus.

3.9.7 If the peak is seen between two loci and either the locus to the right OR left of the peak contains no peak 
(for a single source sample), the allele will be considered to belong with the locus not containing a peak. 
The assignment of the allele designation will be based upon the nomenclature referenced below.

3.9.7.1 If the allele is to the right of the largest ladder peak of the locus to which it has been assigned, 
it will be assigned the designation >X, where X is the largest ladder peak in the assigned 
locus.

3.9.7.2 If the allele is to the left of the smallest ladder peak of the locus to which it has been assigned, 
it will be assigned the designation <X, where X is the smallest ladder peak in the assigned 
locus.
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3.9.8 If the peak is seen between two loci and neither of the surrounding loci have a peak (for a single source 
sample):

3.9.8.1 The base pair size for the allele in question will be compared to the base pair values for the 
largest allelic ladder peak of the lower molecular weight locus and to the smallest allelic 
ladder peak of the higher molecular weight locus.

3.9.8.2 The physical location of the allele in question with respect to the surrounding loci will be 
evaluated.

3.9.8.3 An evaluation of the RFU values of the peak and loci in question may also be helpful.

3.9.8.4 The allele in question will be assigned to the locus with which it falls within an appropriate 
size distance (full repeat(s) away from the closest ladder peak). If it is within an appropriate 
size distance of both loci, it will be deemed inconclusive.

3.9.8.5 The allele will then be assigned the designation >X or <X as follows:

3.9.8.5.1 If the allele is to the right of the largest ladder peak of the locus to which it has 
been assigned, it will be assigned the designation >X, where X is the largest 
ladder peak in the assigned locus.

3.9.8.5.2 If the allele is to the left of the smallest ladder peak of the locus to which it has 
been assigned, it will be assigned the designation <X, where X is the smallest 
ladder peak in the assigned locus.

3.10 Limit of Detection and Stochastic Threshold

The limit of detection and stochastic threshold for DYS385a/b in use were derived from internal validation by the 
Department.

3.10.1 Limit of Detection (LOD)

3.10.1.1 The LOD distinguishes peaks attributable to signal (amplified DNA) from those attributable 
to noise. If a peak does not reach the height of the LOD, it will not be labeled by the GMIDx 
software and will not be used as a called allele in the resulting profile.

3.10.1.2 The limit of detection (LOD) for each dye channel is shown below, with the exception of the 
orange (ILS) dye channel. The orange LOD default will be set to 50 RFU, but can be adjusted 
as needed to capture all ILS peaks in a sample.

3.10.2 Stochastic Threshold (STH)

3.10.2.1 The STH is a height (RFU value) above which one can expect that, in most instances, both 
peaks of a heterozygote at the multi-copy locus DYS385a/b will be observed. If the height of 
a homozygous peak is at or below this threshold, there is a possibility that a true sister peak 
has dropped out. The application of this value to DB sample analysis is designed to reduce the 
incidences of calling a false homozygote.

Channel Color LOD (RFU)
Blue 74

Green 91
Yellow 98

Red 122
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3.10.2.1.1 The STH for DYS385a/b is 515 RFU for 24 second injections and 250 RFU for 
12 second injections.

3.10.2.2 If a sample produces a homozygous peak that is at or below the STH for DYS385a/b, the 
locus will be excluded.

3.11 Printing the Results

3.11.1 All results and associated electropherograms will be maintained in electronic form according to the plate 
number.

3.11.2 If a printed copy of the electropherogram is desired, the y-axes should be set accordingly for printing, as 
shown below. If the axis needs to be changed, right-click on the axis to display the scale settings.

3.11.2.1 Negative Control or Reagent Blank: Y-axis = 0 – 100 RFU

3.11.2.2 Samples, Positive Control, and Allelic Ladders:  Y-axis = scaled individually to largest peak

3.11.3 Print the electropherogram by File>Print.

3.11.4 For printing purposes, the scale setting may be modified, if necessary, to allow visualization of specific 
characteristics of a particular electropherogram.

3.11.5 Should additional documentation be necessary to support an allele designation, other views of the data 
(such as a zoomed-in view of an electropherogram) may be printed and retained, at the analyst’s 
discretion.

REFERENCES:

 AmpFℓSTR® Yfiler™ PCR Amplification Kit User’s Manual. Applied Biosystems, 2006.
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APPENDIX A - REAGENTS

AMPFℓSTR® YfilerTM KIT

Expiration date: Manufacturer’s expiration date 
Purchased from Applied Biosystems, Inc., Foster City, CA., Catalog Number 4359513 for 100 reaction kit 

Kit components included (expiration date same as kit unless specified):

 AMPFℓSTR YfilerTM PRIMER SET
 AMPFℓSTR YfilerTM PCR REACTION MIX
 AMPFℓSTR YfilerTM ALLELIC LADDER 
 AMPLITAQ® GOLD DNA POLYMERASE – 5U/L
 CONTROL DNA (007 MALE DNA STANDARD - 0.10 ng/L, 9947A FEMALE CELL LINE - 10 ng/L) 

NOTE:  The Allelic Ladder will be stored in the post-amplification room once the kit is opened.

ANODE BUFFER CONTAINER

Expiration date: Manufacturer's expiration date
Applied Biosystems, Inc. Foster City, CA, P/N 4393925.

CATHODE BUFFER CONTAINER

Expiration date: Manufacturer's expiration date
Applied Biosystems, Inc. Foster City, CA, P/N 4408256.

GENESCAN™ 600 LIZ® SIZE STANDARD v2.0 

Expiration date: Manufacturer's expiration date
Applied Biosystems, Inc., Foster City, CA, P/N 4408399. 

HI-DITM FORMAMIDE

Expiration date: Three years from date of receipt
Applied Biosystems, Inc., Foster City, CA, PN 4311320, 25 mL each.  
Aliquoted into 550 L aliquots for DB and stored at -20oC.

MATRIX STANDARD – DS-33 (Dye Set G5)

Expiration date: Manufacturer's expiration date
Applied Biosystems, Foster City, CA, P/N 4345833.

PERFORMANCE OPTIMIZED POLYMER – 4 (POP 4) 

Expiration date: Manufacturer’s expiration date 
Purchased from Applied Biosystems, Foster City, CA. P/N 4393715 (384 samples) or P/N 4393710 (960 samples)
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APPENDIX B - MAINTENANCE OF THE ABI 3500XL GENETIC ANALYZER

Refer to Appendix C of the Data Bank POWERPLEX FUSION SYSTEM Procedures Manual 

NOTE:  Refer to the appropriate Applied Biosystems technical protocol for specific spectral instructions.
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APPENDIX C - STORAGE OF ELECTRONIC DATA

Saving Sample files and Project files

1 Sample files and project files generated by the Data Bank using the Applied Biosystems, Inc. 3500xL Genetic 
Analyzer and analyzed using the GMIDx software will be saved onto a storage medium and stored according to the 
following procedures. 

2 After the data has been technically reviewed and found to be acceptable, the electronic sample files and project files 
will be transferred onto a medium for permanent storage. The storage medium will be labeled appropriately to 
indicate the data files are Yfiler samples and with the appropriate plate number. The folders may be deleted from the 
computer after the data has been stored and a backup copy has been made.

3 The storage medium will then be stored securely with the Data Bank technical documentation.

4 If a file(s) needs to be subsequently added to the storage medium for a given plate of samples, the analyst will make 
arrangements with his/her supervisor to have the technical documentation retrieved from storage.


